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Chapter 1. Introduction
Background
The Computerized Assessment and Referral System (CARS) is the result of a collaboration
between the Division on Addiction and the Foundation for Advancing Alcohol Responsibility
(FAAR).

What Is CARS?
● CARS is an easy to use computer guided interview that includes comprehensive
psychosocial
and
mental
health
assessments
adapted
from
the
internationally-recognized Composite International Diagnostic Interview (CIDI).
● CARS is flexible, allowing the user to integrate assessment information from multiple
sessions.
● CARS is easy to understand, providing immediate personalized information about the
mental health disorders for which a client qualifies or is at risk, a summary of other
risk factors and important issues, and a list of resources personalized by a client’s
issues and location.
● CARS packages a powerful mental health assessment tool with a user friendly
interface.
● CARS is a tool that lay people can use easily to administer comprehensive mental
health assessments.

Why CARS is the Right Choice
● CARS provides accurate and reliable diagnostic information that will facilitate
effective treatment planning.
● CARS will improve the intake and data collection processes for programs staff, making
it easier and more efficient for employees to collect, maintain, integrate, and share
information about their clients.
● CARS adapts questions from the CIDI, a tool designed for lay interviewers who may not
have expertise or training in mental health assessment.
● The CIDI has been utilized in large-scale epidemiological and cross-cultural studies
worldwide. It is one of the most comprehensive and thorough instruments currently
available for use in diagnosing substance use and psychiatric disorders. Therefore,
organizers of these studies can be confident that the assessments that they conduct
with CARS are well-validated and reliable.
● The CARS flow and interface makes it easy for clinicians and lay people alike to use it
to administer comprehensive mental health assessments, with minimal time and
effort. There are three primary components of CARS:
1. The assessment consists of different modules administered for each psychiatric
disorder or psychosocial domain.
2. The report generator includes personalized information about the mental
health disorders for which a client qualifies or is at risk, condensing the
information into a streamlined, reader-friendly format.
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3. The referral generator compiles a list of resources dependent upon the client’s
identified disorders and problems, and location.

The Importance of CARS
CARS is able to store and integrate data about clients in a way that allows for:
● Improved assessment accuracy- When program staff attempts to estimate the extent of
psychiatric disorders, in the absence of systematic screening tools, those efforts often
are inaccurate. Standardized and automated assessment and diagnosis tools are
essential to the widespread adoption of mental health screening. CARS provides an
efficient and user-friendly computerized tool that allows staff to effectively screen for
mental health issues.
● Effective treatment planning- CARS provides immediate personalized output that
counselors/staff/intake coordinators can use to inform treatment for individual
clients. The information CARS provides will allow for better targeting of services and
better communication about clients’ needs.
● Efficient use of resources- We have developed CARS to take advantage of open source
software (e.g., Java, Drools, and MySQL) in order to reduce costs to potential users.
The tool will eliminate the need for unnecessary paperwork, and help staff streamline
assessment and optimize face-to-face time with clients.

CARS Assessment Options
There are three assessment options available in CARS, each tailored for site-specific needs. All
CARS assessment options create a personalized diagnostic report that you can share with
clients.
1. CARS: This CARS assessment option includes a comprehensive mental health screener
that covers 13 disorders and problems, and in-depth disorder modules that permit
more thorough evaluation when necessary. CARS also includes a module devoted to
assessing DUI and factors related to DUI recidivism, a module that assesses suicidality,
and a personality disorder screener. Program staff using CARS can choose which of
these modules they want to use and whether they want to use the past 12-month or
full lifetime version of each module. CARS takes between one and three hours to
administer, depending on which modules are selected.
2. CARS Screener: This CARS assessment option includes the same comprehensive
mental health screener as CARS, but it excludes the in-depth disorder modules. The
CARS Screener permits program staff to screen for potential disorders, and identify
mental health areas that might warrant additional attention. The CARS Screener takes
between 20 minutes and 50 minutes to administer.
3. Self-Administered CARS Screener: This CARS assessment option has identical
content to the CARS Screener, but has been modified for client self-administration.
The Self-Administered CARS Screener takes between 20 minutes and 50 minutes for
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clients to complete on their own.

Progressing through the Mental Health Assessment
CARS includes a comprehensive mental health screener (Screener Module), which is included
in all three CARS assessment options.
The CARS Option also includes 13 modules that further assess mental health and substance
use behaviors by asking more exploratory questions. The modules are as follows:
1.
2.
3.
4.
5.
6.
7.

Alcohol Use
Substance Use
DUI behavior
Post-Traumatic Stress Disorder
Generalized Anxiety Disorder
Personality Disorders
Depression

8. Mania
9. Suicidality
10. Panic Disorder
11. Intermittent Explosive Disorder
12. Attention Deficit Hyperactivity
Disorder
13. Conduct Disorder

CARS. Clients’ responses to the Screener Module will direct clients into selected modules. The
Screener Module will direct clients into selected modules only if they show symptoms during
the past year indicating that they might be at risk for having a certain disorder (i.e., if they
qualify for a module). For example: if a client’s answers to the Screener questions for
Post-Traumatic Stress Disorder indicate that they might have experienced symptoms of that
condition during the past 12 months, and the Post-Traumatic Stress Disorder module has
been enabled by the CARS administrator, CARS will direct the client into that module.
Information regarding enabling modules can be found in the “Setting up CARS” and “Adding
Users” sections.
If the client qualifies for a module that is not selected by the CARS administrator, CARS will
not display that module. However, the final diagnostic report will note that the client would
have qualified for the module.
Within each module, the number of questions clients receive depends on the answers to
previous questions within the module. For example, if a client endorses very few symptoms in
the Generalized Anxiety Disorder module, they might complete the module quickly. However,
if a client endorses many initial symptoms, more questions will be asked about the onset,
progression, and symptom patterns they experienced, across time. This is a time-saving
measure; fewer questions are asked if the client has a low likelihood of qualifying for a
condition.
CARS Screener and Self-administered CARS Screener. Both the CARS Screener and the
Self-Administered CARS only include the Screener Module; therefore, the user’s response to
the questions in the Screener Module will NOT trigger the tool to continue into any of the
modules.
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Chapter 2. Getting Started with CARS
Selecting the Right Installation
CARS users can choose from two different types of installation for CARS. You must choose to
install CARS either as a single computer installation or as a network installation.
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Installation and Updating Instructions
Note: During download and installation you might be prompted with one of the following
dialogue boxes. If this occurs, click “Yes,” “download anyway,” or “run anyway” button to
continue with the installation. If you are prompted with “Running this app might put your PC at
risk” and the only on-screen option says “Don’t Run” , select “More info” to enable “Run
anyway”.

Initial Installation
You will find the installation file at the CARS Website in the section titled “The System.” After
registering for an account and as updates become available, the CARS team will send you a
notification email. The latest downloadable version of CARS will be labeled with the most
recent date. The download file for Windows will always end with: .exe. Example:
CARS_windows_1_05.exe.
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Steps to install CARS:
1. To open the CARS download file, locate the file and double click on the icon or right
click on the icon and select “Open”.
2. After the file has been opened, the following security message might appear. Select
“Yes” to continue.

3. The CARS Installer Wizard will then begin preparing the installation.
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4. Once the installation is prepared, a window will appear. Select next to continue with
installation.
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5. The default folder where CARS will be installed is C:\CARS. If you wish to save CARS in
the default folder, slect “Next” and SKIP Step 6.
Note: If you wish to save CARS to a different directory, select the “Browse…” button to
the right and proceed to step 6.

6. Select the folder where you would like to save the CARS tool, then select the OK
button.

13

7. Next, select the folder on the Start Menu where you would like the CARS shortcut to be
installed.
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8. When the setup has finished, select the finish button in the bottom right of the
dialogue box. There is no need to restart your computer; however, CARS will not start
automatically. You will need to go into the folder where it is stored and double-click to
open it. CARS can also be access from the start menu on the desktop by searching
“CARS”.
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Updating the CARS

You will only update CARS when a new version of CARS is released. We will send an email to
the account you or your organization used to register an account at the CARS website.
Every time you install a new version of CARS (e.g., v1.05), CARS will automatically backup
your data from the previous version. Backups are stored on your computer’s “Documents”
folder.
Once you update CARS, DO NOT register or add new users. Registering or adding new users
after updating CARS will overwrite any existing data. To restore saved backup data, see
“Chapter 3: Restoring Data”. Restoring will give you access to all prior registration, user, and
session data.
Steps to update CARS:
1. Locate and download the newest version of CARS on the CARS website.
Updated versions are located on the CARS website on the “CARS Download”
page.
2. Select the file designated for a Windows system (.exe), then select the
download option.
3. Open the CARS installer by double-clicking the installer icon located in your
downloads.
4. Follow the prompts
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4a. Use the default setting “Yes, update the existing installation.”
4b. Then select “Next” to proceed with the installation.
4c. When the setup has finished, select “Finish.”

5. After completing the installation, open the CARS application from the finder
menu.
20

Setting up CARS
New and Returning Users
The first time you open a new installation of CARS, you will be prompted with information
about what to do next. Read the directions on the screen and then select “OK”. If you are a
new user, continue on to the next section, “Site Registration”. If you are a returning user,
please refer to Chapter 3 to learn how to restore previous session data.

Site Registration (CARS Administrators only)
Site registration is the first step in using CARS. During site registration, CARS collects basic
information about your organization.
1. Once CARS is installed, select “Site Registration” from the “Administrator” tab .
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2. The “Site Registration” window will prompt users for an Administrator username and
password. The default Administrator username and password for new users is:
● Username: admin
● Password: carsadmin
3. After a successful login, you will be prompted to change your Administrator password.
Read the password requirements, type in your new Administrator password, and select
“OK”.

4. A new window will appear to confirm a successful password change. This window will
show you what your new password is set as.
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Note: Be careful to remember your new administrator password. If you lose access to your
new administrator password, contact support@carstrainingcenter.org to learn how to
recover your password.
5. Now that your password has been successfully changed, navigate to the administrator
tab and select “Site Registration”. Enter the administrator username and new password
you just created.
6. The Site Registration window will appear. The Administrator should fill in each of the
fields as they are relevant to your specific site. You must enter a valid zip code to complete
the registration process.
7. Once site registration is complete, you will see a pop-up confirming Site Registration.
This message will also contain the steps necessary to begin CARS assessments.
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Chapter 3. Data

Each client’s responses are saved into a database. We encourage you to backup that data on
a regular basis. For example, we suggest you backup once at the end of every work week. This
will ensure that data is not lost accidentally when updating a new version of CARS. If this is
the very first time you are installing the tool, skip to Chapter 4: Using CARS.
Note: Every time you download a new version of CARS (e.g., v1.05) from the website, CARS will
automatically backup your data from the previous version and place the file in your computer’s
“Documents” folder.

Backing up Data

1. To backup your data, select the administrator tab, and then select “Backup User Data”
on the menu.
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2. If you are not already logged in as the Administrator, you will be prompted to enter
your username and password. Use your username and password or find the default
username and password located under “Site Registration” in Chapter 2.
3. A new window will appear. Select “Yes” to continue.

4. A loading screen will appear. This indicates that the backup process has begun.
Note: The speed of backup will differ based on the number of sessions saved in your CARS
database.
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5. Once CARS has completed the backup, a notification will appear. Select ‘ok’.

Note: Backup data is stored in the user default ‘Home’ directory (e.g., “Documents”). Backup
data files will follow the format shown in the following example:
‘carsBackupData_20170111120825.cars’. Each backup will be assigned a unique name
with the date (e.g., the first half of the numbers in the previous example, 20170111) and time
(e.g., the second half of the numbers in the previous example, 120825) appended.

Restoring Data
When to Restore Data:
Restore data immediately after installing the newest CARS update (refer to chapter 2 for
installation instructions). Restored data will overwrite existing data with all previous data
stored in the backup file.
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How to Restore Data:
1. After installing the latest version of CARS, open CARS and select the Administrator
tab, then select ‘Restore User Data’.

2. If you are not already logged in as the Administrator, you will be prompted to enter your
username and password. Use your username and password or find the default
username and password located under “Site Registration” in Chapter 2 above.

3. Return to the Administrator tab and select “Restore User Data”. You will be prompted
with a new window. Select, “Yes”.
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4. You will be presented with a window of your ‘All My Files’ directory with a listing of all of
the files that contains the file extension ‘.cars’. Select the most recent backup file.**

Note: If you have already inputted user data to CARS, you will be unable to restore previous
sessions that you have backed up. When this is the case, you will not see the “All my files”
directory. CARS will generate a popup with the message “User Data exists”.
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5. You will be notified when your backup data has been restored. Select “Ok”.


6. Restart CARS to begin using the restored files.

Transferring Data

To transfer your data to the Division on Addiction, select the administrator tab, and then
select “Transfer CARS Tool Data” on the menu.
Note: A pop-up will notify you if there are no CARS data files to transfer. Select “Ok” to continue.
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Chapter 4. Using CARS
The primary function of CARS is the administration of a comprehensive mental health
assessment. Currently, there are two designs for the administration of the CARS tool: (1)
self-administered, in which the client takes the assessment alone, and (2) a “side-by-side”
model (CARS and CARS Screener), in which staff and clients complete the assessment
together with the staff member controlling the computer.

Starting Out
The CARS Control Center
Welcome to the CARS Control Center. This is the first screen that you will see in CARS. There
are 5 tabs in the Toolbar: File, Administrator, Reports, Log Out, and Help.
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Administrator Functions - The CARS Control Center
1. When attempting to use any of the administrator functions the user will be directed to

login as the administrator. Use your username and password or find the default
username and password located under “Site Registration” in Chapter 2.

2. Here, you will have the option to:
● Access the Site Registration (see Chapter 2: Setting Up CARS)
● Add/modify users
● Transfer data (see Chapter 3: Transferring Data)
● Backup/restore data (see Chapter 3: Backup and Restore)
● Create referrals (more details below)
Adding Users / Logging in to the CARS Tool
Before you can use CARS, you will need to add users. Select any of the options in the Control
Center under each tab to prompt user or administrator login. This login prompt ensures that
only authorized staff can access CARS materials.
Adding Users
After your site is registered, the administrator can create individual user IDs for each staff
member who will be using CARS on this installation. On the Add/Modify User screen, CARS
administrators can also select which modules to include in the CARS assessment. While CARS
currently allows administrators to select different modules for each user, we request that
Administrators select the same modules for all users within CARS.
1. Select the “Add/Modify Users” tab:

2. If you are not already logged in as the Administrator, you will be prompted to enter
your username and password. Use your username and password or find the default
username and password located under “Site Registration” in Chapter 2.
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3. To add a user, select “Add User” in the bottom left corner.

4. Create a username and password for the new user, and then select “Add User”.

5. In order to view and login as the new user, you must exit out of CAR completely and
then re-open CARS.
Note: Sites that are ONLY using the CARS Screener Option, skip Module Selection. For sites
that plan on using the CARS Option (i.e., the Screener Module and other modules), continue
to Module Selection below.
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Module Selection
Each module contains specific questions to assess and diagnose a particular psychological
disorder or class of disorders. The CARS administrator can select modules based on each
CARS user’s needs and interests. CARS Screener is mandatory, and is preselected. This
ensures that each client completes a brief screen. Depending upon the pace of the interview
and how many modules are selected, the full length of the assessment may take anywhere
between 20 minutes and 3 hours.
Enabling Module Access
1. To enable module access for individual CARS users, select the “Add/Modify User” tab
in the toolbar.
2. If you are not already logged in as the Administrator, you will be prompted to enter
your username and password. Use your username and password or find the default
username and password located under “Site Registration” in Chapter 2.
3. On the “Add/Modify User” window, either select “Add User” and enter a unique
username and password or select an existing user and then “Modify User”.
4. To view modules currently assigned to an existing user, select “Current Modules”. To
change modules for the selected user, select “Changes Modules”.

Note: If you do not select any modules while adding a new user, the Screener Module will be
the only available module for the user. Modules can be added later using the “Modify User”
function. The Administrator cannot be assigned modules.
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5. The “CARS Module Selection Options” window will provide a list of modules that users
can select. Currently, CARS supports only selecting 12 month or lifetime screening
time frames, but not both. Unavailable time frames are indicated by grey radio
buttons.

Note: In the tool you will have to scroll to see all the module options.

6. After selecting and updating the modules for a user, select “Update” in the bottom
center of the “CARS Module Selection Options” window.
7. You will return to the “Set CARS User options” window.
8. Select “Update User” to save changes.
Note: You will lose all changes if you do not select “Update User” when you are finished.
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9. After creating or modifying users, restart CARS by exiting completely and re-entering
CARS to see your changes.
10. Repeat these steps to add additional users.

Viewing Active Modules
The purpose of viewing the module list is to make sure that the counselor/staff has all the
modules they want activated. This function can be used as a way to double check that the
assessment will continue to the desired modules.
1. Select “Add/Modify User” under the “Administrator” tab in the control center.
2. If you are not already logged in as the Administrator, you will be prompted to enter
your username and password. Use your username and password or find the default
username and password located under “Site Registration” in Chapter 2.
3. Select the user you would like to view active modules for, then select “Modify User”.
4. A new window will appear. Select “Current Modules”.
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5. A new window will appear. This window shows all currently active modules assigned
to this use. In the example below, the user has only the “Enhanced screener” and the
“Generalized anxiety” modules activated. Modules that are not selected will not
appear in the “Current Assigned User Modules” screen.

6. After all the users are added, the registration process is complete. Click exit.
Now individual users can now begin to use the tool.
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Adding a Referral Database
CARS allows users to add in their own referral database. The Administrator can add client
referrals relevant to inpatient/outpatient mental health treatment, substance use treatment,
emergency care locations, etc. Adding this information will allow CARS to match the client’s
zip code to referral data and suggest available treatment referrals within a range of 50 miles.
It is important that administrators enter all the known treatment referral locations in their
area. Follow these steps to add a referral location:
1. In the Administrator tab, select “Add Referral Data”

2. Log in as the administrator using the updated username and password or find the
default username and password located under “Site Registration” in Chapter 2.
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3. Select “Add new Referral”

4. Enter the information in the relevant fields and select “Add”.

5. After adding referrals, the administrator also has the option to Look-up and Modify
referrals.
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6. To Look-up/Modify referrals, select “LookUp/Modify Referral”.

7. Here you will have the option to Look-up a referral by the Facility Name, State, Zip
Code, and Telephone Number.
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8. To Modify a referral, simply right click the referral site you wish to edit and select
“Display/Modify referral”.
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Other Counselor/Staff/Intake Coordinator Functions:
CARS also offers functions within the Control Center that are accessible by staff members
other than the Administrator. These options include initiating a new session, generating a
report, and accessing the User Manual.

Accessing the User Manual
1. To access the User Manual from within CARS, select the Help tab in the Control center.
A drop down menu will appear.

2. Select “User Manual”.
3. The User Manual will open in a new window.

Generate a Report from a Previous Session
1. To generate a previous report, select the Reports tab in the Control center. A drop
down menu will appear.

2. Select the type of report you would like to generate.
3. A screen will appear with the report you requested.
Note: For a detailed discussion of Reports, see Chapter 5. Reports.
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Starting an Assessment
You are ready to begin a session once the following steps are completed:
1.
2.
3.
4.
5.

Choose a networked or standalone installation.
Install CARS.
Register your site.
Add Users.
Add referral locations.

Initiating a Session
1. To begin a new assessment, select the File tab in the CARS Control Center. A drop
down menu will appear.
2. Select “New Cars Session”.

3. If you are not already logged in as a user, you will be prompted to enter your username
and password.
Note: The Administrator cannot start a session or be assigned modules. In order to start a
new session, the Administrator must be logged out. To log out, select the “Logout” tab in the
CARS Control Center. A drop down menu will appear. Select “Logout”.
4. Enter the client’s home zip code. The client zip code helps CARS decide the order of
referral locations shown in the client diagnostic report.

Note: The client zip code helps CARS decide the order of referral locations shown in the client
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diagnostic report.
5. Select the appropriate assessment option and enter a Client ID. See below for a brief
description of each assessment option. For detailed information on assessment
options, see Chapter 1. CARS Assessment Options.
Note: Enter a unique ID for each unique client. Use a Test ID (e.g., Test_1, Test_2, Test_3) if
the user is running a practice session. See “Testing or Running a Practice Session” below for
more information on running a practice session.
● CARS Screener is the Screener Module only.
● CARS includes the Screener Module and any module assigned by the Administrator.
● Self-Administered CARS Screener is self-administered. This CARS option includes the
Screener Module only.

5. After you have selected your assessment option and entered a Client ID, select
“Continue”.
Testing or Running a Practice Session
The CARS team encourages CARS users to practice using CARS either on themselves or with a
peer. This will build familiarity with CARS and its functionality. In order to help differentiate
between practice sessions and client sessions, please use a test ID (e.g., Test_1, Test_2,
Test_3) when entering the Client ID into the Client ID text field.
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Navigating the CARS Toolbar During a Session
During a session, the CARS assessment window includes a toolbar similar to the CARS Control
Center. The CARS Toolbar includes the following options: File, Answer, View, and Help.
File
1.) Select the file “File” tab on the CARS Toolbar. A drop down window will appear.
2.) The drop down window will include two options: “Lock” and “Exit”.

Note1 : “Lock” allows CARS Users to pause the assessment. This option allows CARS Users to
prevent unauthorized access to client information while away from the program. To return to
the assessment, enter your username and password to return to the assessment.
Note2 : “Exit” allows CARS Users to leave the assessment and return at another time. When you
select “Exit”, a message will appear asking if you would like to save the session. Select “Yes” to
store your session. Select “No” to cancel and return. Saved sessions can be recalled from the
CARS Control Center under “Previous CARS Session” in the “File” tab”. For a detailed discussion
of continuing a saved session, see Chapter 4. Continuing a Session
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Answer
The Answer tab contains options that help provide answers to specific interview questions.
Select the “Don’t Know” option if the client does not know an answer to a question. Select
the “Refused” option if the client refuses to answer a question. Both of these options have
keyboard shortcuts, pictured below.

If a question appears inside a grid, you must select the corresponding row in the grid before
choosing “Don’t Know” or “Refused”. If the question has multiple parts, you must select
section individually. There are visual cues to indicate that you selected “Don’t Know”
(highlighted yellow) or “Refused” (highlighted red).
Advance to the next question by selecting “Next” once all questions are answered.
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View
The “View” tab includes options for navigating the toolbar nested on the right side of the
assessment window. These options include history, notes, and respondent booklet.

History
The “History” tab is the default tab shown in the right side of the assessment window. It
displays a question tree of all questions a client has answered so far. You can view an answer
to a question by selecting the question label or by hovering your cursor over the label.
Note: Returning to previously answered questions is not permitted.

47

Notes
The “Notes” tab can be found in the right side of the assessment window. It allows CARS
users to add notes or remarks about a particular question during the interview. Notes might
include information about the client’s response or suggestions for question revisions. Notes
can be generated in a report at the end of the session.

Respondent Booklet
The “Respondent Booklet” tab can be found in the right side of the assessment window. It
displays graphics, lists and other visual aids might assist clients in answering questions. This
tab automatically opens when a question provides additional information. CARS Users can
also select this tab when prompted by interviewer instructions.
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Help
The “Help” tab includes the “User Manual MAC”. Selecting this option will launch the User
Manual from your desktop.

Note: This User Manual comes with your current version of CARS and is available offline. You can
also download the most recent version of the CARS User Manual from the CARS website.
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Continuing a Session
Continuing a saved session happens when a session is ended prematurely, but the user
wishes to return to the session later. To continue a saved session follow these steps:
1. Go to the File tab in the Control Center.

2. Select “Previous Cars Session”
3. A window with a list of the previous CARS sessions will appear. Control click on the

session you would like to continue, and select “Continue CARS Session”.

4. The previous session will then load from the last question that was answered.
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The Question Screen
The question screen is what you will be interacting with the most as you go through CARS.
There are several types of question screens you will encounter as you go through the
interview. Some have only one question, and some have multiple questions in a grid format.
The text immediately next to a question number. These are what you will read out to your
clients as you perform the interview.
Example of text question:

Some question screens display multiple questions in a grid format. Treat each grid row as an
individual question. To answer a question in a grid with “Don’t Know” or “Refused”, select a
row by clicking it. Then select the “Answer” tab and the appropriate option or select the
corresponding keyboard shortcuts.
Note: You must complete all questions within a grid to advance.
Example of grid prompt:
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Some grids display multipart questions. These questions have more than one column to the
right of the question. Answer these grids row-by-row from left to right. Some columns may be
disabled initially, but will become active depending on the answers in other columns. To
select “Don’t Know” or “Refused” for a multipart question, select the appropriate portion of
the question and select “Don’t Know” or “Refused” in the Answer tab or press the
corresponding keyboard shortcut. All active questions must be answered to continue.

Some questions include blue text above the question prompt. These are interviewer
instructions and interviewer notes.
Interviewer notes begin with “INTERVIEWER:” and provide extra information to help the you
proceed with the interview. These should not be read out loud to the client.
The interviewer instructions are extra prompts for you to address to the client being
interviewed if they are having difficulty answering a question. These can be read out to clients
if necessary.
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CARS Answer Types
CARS has many answer types that you will experience as you complete interviews.
These include:
● Text boxes
● Radio buttons
● Check boxes
● Combo boxes
Text Boxes
There are multiple types of text boxes in the tool. You can answer them by clicking inside the
box, and filling in a numerical or text response. Some text boxes may only support a certain
number of characters, while others will only support numbers. For questions with a character
limit, we will indicate this in the interviewer notes.

Radio Buttons
Radio buttons are round buttons that allow you to select only one option at a time. They can
either be “Yes/No” answers or an answer with multiple options. Select the option you would
like to use, and the button will fill in, indicating an option is selected.
Checkboxes
Checkboxes are square buttons that allow you to select multiple answers at once. Select all
options the client endorses; each option will display a check, indicating that it is selected. You
may select multiple checkboxes at once, although specific questions might limit the number
of options that can be selected at once.
Combo Questions
Some questions combine different answer types. The most common of these is a text box
combined with radio buttons. All parts of combo questions must be answered before
proceeding.
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Chapter 5. Reports
CARS generates user-friendly individualized reports for each client based on the assessment.
For Diagnostic and Statistical Manual of Mental Health Disorders (DSM) based mental health
disorders included in the assessment, the report will include basic descriptions of any
disorders for which a client may qualify or be at risk. These reports are designed to be shared
with clients. When you share a report with your client, please be sure to go over the entire
document with them, and ensure that they understand all parts of it, and leave ample time
for questions.

How to Generate a Report
CARS will give you an option to generate a report after completing each assessment. Select
“Yes” to the “Generate Report” message, and CARS will automatically generate a report.

You can also generate a report from the Reports tab of the CARS Control Center. The
“Generate Previous Diagnostic Report” option generates a report for the latest session. The
“Generate Raw Data Report” option brings up a list of questions and responses from the
latest session. “Generate Question Notes” will generate a PDF of the interviewer’s notes from
the latest session. See Chapter 4: Other Counselor/Staff/Intake Coordinator Functions.
Reports are generated in PDF form, and will pop up automatically after they are created. They
are also saved locally. To access them, go to “All My Files” and search CARS.
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Report Components
Executive Summary
The Executive Summary provides a brief synopsis of all the information in the report. It is
designed to provide easy access to all the important information contained within the report.
The mental health profile table outlines the disorders that the client may have met full
criteria for; met partial criteria for (subclinical); or screened into, but not tested.
Detailed Diagnostic Reports
CARS generates a detailed diagnostic report for each disorder for which a client may qualify
or be at risk. Each report is composed of an explanation of the disorder, as well as a detailed
description of the symptoms and information about the length and severity of the disorder.
CARS will provide diagnostic reports for some DSM-IV Axis I disorders, as well as a diagnostic
report for personality disorders and a risk report for suicidal ideation.
Risk Assessments
The Biopsychosocial Risk Assessment reports information about biological, psychological,
and social experiences in the client’s life that might be relevant to his or her diagnosis.
The DUI Recidivism Risk report provides a brief summary of risky behaviors that your client
may have reported during the CARS interview. A speedometer scale highlights the severity of
the client’s risk of re-offending, from moderate to very high risk.
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Referrals
The report can also include a list of referrals for behavioral health services from which your
client might benefit. These referrals are sorted by zip code and are contingent upon the
amount of information each site is able to provide about local services.
In order to have relevant local referrals as part of the report each site will be responsible for
adding all referral locations with the information for the relevant mental health and
substance use service providers in that state or jurisdiction. To do this, see Chapter 4: Adding
a Referral Database.
Required information includes:

Facility Name, Organization (if part of a larger organization), Street Address, City, State, Zip
Code, phone number, If they treat Mental Health Disorders (Yes/No), if they Treat Substance
Use Disorders (Yes/No), Type of Care (inpatient, outpatient, residential), and website (if
available).
Optional Information includes:
Specialties (if the location specializes in treating any particular disorder(s), which one(s)),
types of insurance accepted, Medicare/Medicaid accepted (Yes/No), gender or age
restrictions (e.g., men only, or 18+ only), options for family/homeless/non-English speakers,
and public transportation options to reach the treatment provider.
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Troubleshooting
If you encounter a problem that you are unable to find a solution for in the troubleshooting
guide, please visit the “Training & Resources” section of the website. If you do not find the
answers you need there, please give us a call or send an email to the CARS Training Center.
To report an error, please provide as much of the following information as possible:
▪

Your name

▪

Date and time of error

▪

Your computer operating system

▪

Which version of CARS you are running

▪

Type of installation (standalone or network)

▪

A description of the error, including the question number

▪

Screenshot, if possible

▪

List of any other applications running on your computer at the time

▪

Description of any recent changes to your computer, if applicable

Send your description to support@carstrainingcenter.org
You can also use this procedure to provide your suggestions on improving CARS and its
features.
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